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1750 Power Recorder 

Introduction 
The Fluke 1750 Power Recorder is a comprehensive yet easy to use system for 
power quality investigations. The 1750 Power Recorder, referred to hereafter 
as simply “the Recorder”, consists of a power recorder instrument, a wireless 
handheld Personal Digital Assistant (PDA) for control and setup, and a 
powerful yet easy to use PC application, Power Analyze. Four 400 A current 
probes are provided as standard equipment. A wide range of flexible and 
clamp-on current probes are available from Fluke. 

Key features of the 1750 Power Recorder are: 

• No PC needed for setup 
Using the included a wireless-enabled Personal Digital Assistant 
(PDA) as a controller, you do not need a PC to configure the 
Recorder, troubleshoot connections, preview data, or download the 
recorded data. Downloaded data goes onto the SD memory card 
plugged into the 1750, not directly to the PDA. The range of the PDA 
with the wireless link is about 15 meters (45 feet) from the Recorder. 

• Simplified test lead connections to the power network 
Simply connect a voltage probe to a conductor on each phase that you 
want to record. On the current inputs, the Recorder automatically 
identifies what type of probe is connected. The Recorder then 
configures its measurement system appropriately for the model of 
current probe you are using.  

• Connection diagrams for the supported power network configurations 
(delta, Wye, and others) appear on the handheld PDA controller. 
Once you make connections, you can view live readings and a phasor 
diagram on the PDA to confirm the connections. If a phase channel is 
wired incorrectly, you can swap the phase to another channel by 
changing an internal Recorder setting using the PDA, and then 
reconfirm correct readings. 
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• Internal Uninterruptible Power Supply (UPS) 
An internal NiMH (Nickel-Metal-Hydride) battery pack and charging 
system maintain data capture continuity through power interruptions 
of 8 minutes or less. 

• Automatic disturbance capture 
The Recorder uses an automatic, self-learning threshold routine, 
which means you do not have to set any event threshold limits before 
you start recording. You detect and display power quality events 
(disturbances) using the Power Analyze software on a PC after the 
event has been captured. You define thresholds for events after data is 
stored on the PC. This is called the "event detector" in the software. It 
does not make permanent changes to the data file, so you can 
experiment with different thresholds after the fact without worrying 
about losing data. 

With these features, there is little else required to set up and start recording the 
data to conduct a power quality survey. Should you want to extensively 
analyze collected data, the procedures described later in this manual review the 
transfer of data from the Recorder to the PDA, and finally to a PC. Data may 
then be analyzed using Power Analyze on a PC. Extensive online help is 
provided in the Power Analyze software on the product CD shipped with the 
Recorder. 

Contacting Fluke 
To contact Fluke, call: 

1-888-993-5853 in USA  
1-800-363-5853 in Canada 
+31-402-675-200 in Europe 
+81-3-3434-0181 in Japan 
+65-738-5655 in Singapore 
+1-425-446-5500 from anywhere in the world 

Or, visit Fluke’s Web site at www.fluke.com 

To register your product, visit register.fluke.com 

To contact Technical Support: 

fpqsupport@fluke.com or 888-257-9897 

register.fluke.com
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Safety Information 
The Recorder complies with EN 61010-1 600 V, CAT IV, 1000 V CAT III 
overvoltage rating. See the Specifications section for a full agency compliance 
list. Table 1 lists symbols that appear on the Recorder and in this manual. 

XWWarning 

To avoid electrical shock or fire: 

• Review the entire manual before using the 
Recorder and its accessories and observe all 
warnings and cautions. 

• Avoid working alone. 

• Do not operate the Recorder around explosive gas 
or vapor. 

• Use only insulated current probes, test leads, and 
adapters as supplied with the Recorder, or 
indicated as suitable for the Recorder. 

• Before use, inspect the Recorder, voltage probes, 
current probes, leads, and accessories for 
mechanical damage, and replace when damaged. 
Look for cracks or missing plastic. Pay special 
attention to the insulation surrounding the 
connectors. 

• Remove all probes, test leads, and accessories that 
are not in use. 

• Make sure the Recorder is properly connected 
through the power cord to protective earth ground. 

• Do not apply input voltages above the rating of the 
Recorder as shown on the input panel. 

• Do not apply voltages in excess of the marked 
ratings of the voltage probes and current probes. 

• Do not use exposed metal BNC or banana plug 
connectors. 

• Do not insert metal objects into connectors. 
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Table 1. Symbols 

Symbol Description Symbol Description 

X 
Hazardous voltage. Risk of 
electrical shock. Precedes 
Warning 

W 
Risk of danger. Important 
information. See manual. 
Precedes Caution and 
Warning. 

P 
Conforms to requirements 
of European Union and 
European Free Trade 
Association (EFTA). 

~ 

Do not dispose of this 
product as unsorted 
municipal waste. Contact 
Fluke or a qualified recycler 
for disposal. 

) 
Canadian Standards 
Association. [ Note: 
Canadian and US. ] 

J Protective conductor 
terminal. 

CAT III 

CAT III equipment is 
designed to protect against 
transients in equipment in 
fixed-equipment 
installations, such as 
distribution panels, feeders 
and short branch circuits, 
and lighting systems in 
large buildings. 

CAT IV

CAT IV equipment is 
designed to protect against 
transients from the primary 
supply level, such as an 
electricity meter or an 
overhead or underground 
utility service. 
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Standard Accessories 
Table 2 describes the standard accessories that ship with the Recorder. Other 
optional accessories are also available. See the 1750 Operators Manual for a 
complete list. 

Table 2. Standard Accessories 

Description Part Number 

Ethernet cable, 3 meters, yellow 2402854 

Colored plastic clips for test leads (32 clips, 8 colors, 4 clips 
each color) 

2157607 

Model TLS430, test lead set including cable and clips  2157713 

512MB Secure Digital (SD) Memory Card for downloading 
data 

2386744 

Model 3140R, 400 A Probes (3) 2277216 

AC power cord, 3 meters 2441360 

Personal Digital Assistant (PDA) with docking station 2386780 

CD ROM Manuals and Software 2386771 

1750 Getting Started Guide 2386767 

Sheet of Front Panel Decals 2436261 

Sets of international ac power plug adapters for the PDA 
charger  

2583479 

International adapters for the Recorder power cord 2441372 
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Features 
The Recorder front panel is illustrated in Figure 1 and described in Table 3. 
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Figure 1. Fluke 1750 Power Recorder 
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Table 3. Input Terminals and Controls 

Number Description 

A Standard 120/240 V 50/60 Hz power input for Recorder power 

B Voltage indicator 
Steady   Voltage is present, not overloaded 
Blinking   Voltage overload (overload threshold 1100 V) 

C Five voltage measurement inputs 

D Removable Secure Digital (SD) memory card for transfer of large 
quantities of data. You can remove the card from the Recorder, 
insert in the PDA and transfer data to the PC via the “synchronize 
data” feature of the PDA. 

E SD status indicator 
Steady green SD card inserted 
Blinking   Busy - do not remove the card 

F Wireless Controller Status Indicator 
Steady Blue  Wireless controller enabled but not  
    communicating 
Blinking   Wireless controller communicating 
Off    Disabled 

G Ethernet port. TCP/IP via Ethernet is used to connect the Recorder 
to a PC for downloading recorded data, and for configuring the 
Recorder when not using the PDA. 

H Busy Indicator 
Blinking   Network is busy 

I Link indicator 
Off    No link 
Steady   Link Present 
Blinking   Communicating (with PDA or PC) 

J Current Measurement Terminals (5) 
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Table 3. Input Terminals and Controls (cont.) 

Number Description 

K Current indicator 
Steady   Current probe in normal range 
Blinking   > 110% of probe range, use a higher range 
probe 
Off    Current insufficient to measure 

L Red/Green LED 
Steady green  AC input power normal 
Green/Red blinking Recording 
Blinking red   Recorder running on UPS 

M Ground Terminal  
Connecting the supplemental ground terminal and the line cord 
safety ground to different ground potentials creates a ground loop 
that can damage the Recorder. To avoid this, use the 
supplemental ground terminal only when no protective earth 
ground connection exists through the line power cord. If there is 
any chance that a safety ground connection does exist through 
the line power cord connection, make sure to connect the 
supplemental ground terminal only to the ground system used by 
the ac receptacle that powers the Recorder. See Figure 2. 
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WCaution 

Connecting the supplemental ground terminal and the line 
cord safety ground to different ground potentials creates a 
ground loop that can damage the Recorder. 

Potential
Ground
Loop

Correct,
No Ground Loop

Optional Protective
Chassis Ground

(See detail below)

Different Power System

OK

Line Power Cord

Power Network Being Measured

See     Caution Above

Incorrect,
Creates Ground Loop

GND

N

ØC

ØB

ØA

 
azd11f.eps 

Figure 2. Connecting the Supplemental Ground Terminal 
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Charging the PDA Battery 
Your PDA is shipped with a discharged or partially charged, rechargeable 
battery. You should fully charge the battery before setting up the device, and 
recharge it regularly. Refer to your PDA user’s guide for detailed information 
about the battery. 

WCaution 

Do not leave important data on the PDA. If the battery 
discharges completely, you will lose all data not stored in 
File Store (ROM). Discharging the battery completely is 
similar to performing a hard reset. Refer to the PDA user’s 
manual for more information. 

Installing the Software 
This section describes how to install Fluke Power View software on the PDA 
and Fluke Power Analyze software on your PC. Keep your product CD in case 
you need to reinstall this software in the future. You should periodically check 
the Fluke website: www.fluke.com to see if any 1750 firmware or application 
software updates are available for download. 

Installing Power View on the PDA 

1. Insert in your PC the CD that ships with your PDA. Follow the  
on-screen instructions to install the ActiveSync software that allows 
your PC to communicate with the PDA.  

2. Put the PDA in the docking station and establish a partnership 
between the PDA and your PC. Keep your product CD in case you 
need to reinstall this software in the future. 

3. Insert the CD that ships with your Recorder in the CD-ROM drive on 
your PC. 

4. A window appears that lists options on the CD. If the install software 
window does not automatically appear, do the following: 

a. On the Windows taskbar, select Start, then Run. 

b. Type d:\loader.exe (where d: is your CD drive letter). 

5. Select Install Software. 
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6. Select Install Fluke Power View. 

7. Power View will be installed in the Programs folder on the PDA. 

8. To start Power View select Start, and then Programs on the PDA. Tap 
the Power View icon ( ) to start using the application. 

PC System Requirement for Power Analyze 

• Windows 2000 Professional at minimum, Windows XP or higher 
recommended. Administrator privileges are required to install 
software on Windows 2000 or XP. 

• PC with 300 MHz or higher processor clock speed, Intel 
Pentium/Celeron family, or AMD Athlon/Duron family, or better.  

• Processor Recommended: 1 GHz or higher, Pentium 4, AMD Athlon, 
or better. 

• 256 MB RAM (1 GB recommended). 

• 1024 x 768 or higher resolution video. 

• Keyboard and mouse. 

Installing Power Analyze  

Before installing the software on your PC, make sure you have Internet 
Explorer version 5.01, or later appropriate to the language or culture settings of 
the operating system installed on your computer.  

WCaution 

Do not remove the CD until after you have successfully 
installed the software, rebooted the machine, and opened 
the application. 

1. Insert the CD into your CD-ROM drive. 

2. A window appears that lists options on the CD. If the window does 
not automatically appear 

a. Use Windows Explorer to locate the “setup.exe” file on the CD. 

b. Double-click “setup.exe” to launch the installation program.  
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3. Select Install Software. 

4. Select Install Fluke Power Analyze. 

5. Follow the installation instructions that appear. After software 
installation is complete, the Power Analyze icon  appears on your 
desktop. 

6. Start Power Analyze on your PC by choosing Start > All Programs 
> Fluke > Power Analyze > Launch Power Analyze or double-click 
the Power Analyze icon  on your desktop. 

After the installation is complete, please take a few minutes to complete your 
product registration. You can register quickly online (preferred) at 
http://register.fluke.com or you can print the form and fax it to the number 
provided on the form. Product registration is very important since it allows you 
to get free software updates and helps us provide you with the fastest and most 
efficient technical support.  

Note 

When Windows XP Service Pack 2 is installed on your PC, Power 
Analyze can no longer browse for 1750 Power Recorders. This occurs 
because Service Pack 2 installs a firewall that does permit Power 
Analyze to receive browse data. You may need to change your 
Windows firewall settings to allow the program FPA.exe to use ports 
18571 (TCP) and 18572 (UDP). For more on changing firewall 
settings, refer to http://support.microsoft.com.  

Installing the Power Recorder at a Facility 
This section describes the steps you need to take to set up the Recorder at a 
facility and begin a recording session. 

Work Flow 

There are three distinct stages for a recording session. 

• Set-up  
Set-up, hookup, and verification of connections and measured signals. 
This is when you will want to clear the Recorder memory (not 
required, but good practice because data download when finished 
only contains your new data), make any desired Recorder setting 
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changes, and insert annotations and/or an optional Start mark into the 
recorded data stream. Annotations are messages or notes you insert 
into the data stream during a recording session. 

• Interim checkup, mid-recording session (optional) 
At this time, you may want to re-check all the live input signals, and 
download the data recorded since the beginning of the recording 
session. This does not interfere with ongoing recording in any way. 
Annotation capability is always available during the recording 
session. 

• End of recording session 
You can re-verify if desired, correctness of live data and then 
download data, power off the Recorder, and pack up for transport. 

Installing the Recorder  

To install the Recorder at a facility, follow the basic steps below.  

1. Position the Recorder within 2 m (6 ft) of the monitoring location. 

2. The Recorder can be set on the floor or a table, or attached and 
secured to a pole or other mounting surface. The Recorder can be 
oriented vertically or horizontally. 

3. Connect the Recorder to a 100 to 240 V ac power source, 50 or 60 
Hz. 

• Connect the power cord to the Recorder using the appropriate 
supplied adapter. 

• Connect the power cord to a properly grounded wall outlet. 

WCaution 

• Ground the chassis before you do anything else. 

• Be sure to plug the power cord into the Recorder 
panel BEFORE connecting it to an outlet 

4. Plug the power cord into a properly grounded wall outlet. 

5. Turn on the PDA and tap the Power View icon  to launch Power 
View. 
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6. If a Recorder is within range and is not password protected, the Home 
screen for live data appears. 

7. If more than one Recorder is within range, select one Recorder for 
use. 

8. If you have previously established password protection for the 
Recorder using the Power Analyze PC software, you must type the 
correct password in the Password text box and tap the Enter button. 
(Password protection is established for a specific Recorder using 
either the Setup Password menu in Power View or the Power Analyze 
software). 

9. All LEDs should flash ON, then OFF, and then each should turn ON 
and OFF in sequence. The LEDs will then remain on if you make 
secure test lead connections and there is sufficient voltage and 
current. 

Connecting the Recorder to the Wiring 

After you have set up the Recorder you are ready to connect the voltage leads 
and current probe or flexi-probes to the power network being tested. Refer to 
the Power Type diagrams provided on the PDA or in the 1750 Operators 
Manual. 

In most cases, you should install the current probes first. Because they are 
clamped around wires, current probes are usually more secure than voltage 
probes. Examine the conductors you are about to connect to and determine if 
you should attach the current probes to the phase wires or busbars before you 
connect the voltage probes.  

1. Select and attach the appropriate current probes to the Recorder. 

2. Select and attach the appropriate voltage test leads and probes to the 
Recorder. 

Note 

If your power connections require potential transformers (PTs) or 
current transformers (CTs), you can use the ratio settings in Power 
View to set the Recorder to display readings as they exist on the 
primary side of the PT and CT (for example, 12000 V). 
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3. Connect the Recorder to the wiring by first connecting the 
measurement ground test lead to the distribution system ground, and 
then the neutral probe to neutral. 

4. Connect the ground clamp to the distribution system ground and the 
neutral clamp to neutral, with the arrow on the current probe pointing 
towards the load (away from the source) in each case. 

5. Connect the remaining current probes to the power network.  

• The arrow on the clamp should point toward the load. 

• Use the color-coding on the leads to help you connect the probes 
to the correct phases, neutral and ground.  

6. Connect the remaining voltage probes. 

Note 
Make sure the voltage probes and current probes are paired correctly, Phase 
A (L1) voltage to Phase A (L1) current and so forth. Calculations are made in 
pairs and cannot be changed after data is recorded. The leads for the voltage 
probe and current clamp of the same color should be attached to the same 
phase wire or busbar. 

7. Check the LED for each phase to make sure a connection is 
established.  

• When a phase LED is ON or lighted, you know that the 
connection is active and that voltage and current is within the 
normal range.  

• When a phase LED is BLINKING, you are connected but the 
voltage or current is exceeding the normal range or exceeding the 
range of the probe that you are using. 

• When a current LED is OFF or unlit, there is insufficient current 
present in the line. 

Verifying Your Connection 

Before you leave the Recorder to accumulate data at the facility, double-check 
the connections.  
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• Make sure the current probes are secured and completely closed 
around the conductors and that the voltage and current LEDs are 
steady-on. 

• Use the PHASOR screen on the PDA to verify that the voltage and 
current connections are correct. You can swap the connections using 
Power View if they are incorrect. 

Finishing UP 

After making any corrections to the connections, recheck the PHASOR 
diagrams to confirm your connection. Make sure the nominal voltage, nominal 
line frequency, and power type (delta, wye, other) are correct before you leave 
the Recorder. It is a good practice to insert a Start Mark when you are finished 
with all settings so you can download data and ignore useless readings and 
events common at the beginning probe connecting activities. 

Managing Recorded Data 
Recorded data resides in the Recorder on an internal non-physically accessible 
flash memory circuit. It is not transferred to an SD memory card in the 
Recorder’s SD memory slot until you request a download action using the 
PDA or an attached PC. 

It is never technically necessary to erase internal memory. When the Recorder 
has new data to record, it does so automatically, overwriting the oldest data. 
You can erase internal memory for security reasons, or if you want to simplify 
what you will be seeing in the download data dialog box. The start and end 
times will represent one recording session when old data is erased. 

Note  

Data is not removed from internal Recorder memory until you erase it 
using Power View software on the PDA or Power Analyze software 
on your PC. 
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Downloading Data and Erasing Memory 
Use the Data menu options to manage the Recorder memory and download 
recorded data to the SD card plugged into the Recorder’s (not the PDA) SDA 
card slot. You are downloading recorded data from the flash memory to an SD 
card in the Recorder. When you want to use that data, you must move the card 
to the PDA. You can later copy the data to your PC for review using the Power 
Analyze software. Tap 1750 Internal Memory to view the Download screen. 

 
 

The Download screen shows a three-phase rms V strip chart with date and 
timescale shown. This represents the data in the Recorder internal memory. 
The default settings of the start and stop times is everything in memory, to 
download ALL, tap the Write to SD button. 

The gray cursor lines right and left with triangular arrowheads at the bottom of 
the screen show the start and stop times currently selected for download. Green 
and red flags are START and STOP mark annotations inserted during the 
recording session. Yellow flags are file name annotations inserted during the 
recording session , or setup parameter changes that change the data 
significantly, such as nominal voltage or power type. 
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If the SD storage card already contains data files, it may not have room for the 
new download. Power View alerts you to this condition and asks if you would 
like to erase the SD card before downloading.  
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The Memory Card Full message appears for 5 seconds, followed by the screen 
below. You can also access the download menu by selecting Data\Recorder 
SD Memory. 

You can delete files as necessary, and when satisfied that there is room on the 
card, proceed to write the selected internal Recorder memory data to the SD 
card. 

Fluke Power View 11:35

Data  View  Setup

ok

Stored files:

File Name Date Size

*larson BLDG -SN12345

SD CARD FILES

 
When there is room on the card, a message confirming the download will 
appear. 
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You can also tap the Erase Recorder Memory from the Data menu option, 
and tap the Erase All button to erase all power quality data stored in the 
Recorder. Even then, if you want you can leave old data in Recorder memory. 
It will be overwritten automatically when you start your next Recorder session, 
so it never has an adverse effect on recorded data quality or quantity. 

 



 1750 Power Recorder 
 Downloading Data and Erasing Memory  

  21 

When you choose to Erase All, the following popup caution “Are you sure?” 
appears on the screen. 

 
Note 

You can also download data by connecting your PC directly to the 
Recorder with an Ethernet cable and run Power Analyze in the 1750 
Live mode. All of the functions (controller, PDA, and Power View) 
are duplicated in 1750 Live mode. 
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Power Type Diagrams 
Power type diagrams are provided on Power View and Power Analyze and can 
be referenced when you are setting up nominal power on the Recorder. The 
diagrams are used an aid in making the correct test lead connections. The 
following power type diagrams are for the standard power configurations: 

• One-Phase Plus Neutral 

• One-Phase IT No Neutral 

• One-Phase Split Phase 

• Three-Phase Wye 

• Three-Phase Delta 

• Three-Phase IT 

• Three-Phase High Leg 

• Three-Phase Open Leg 

• 2-Element Delta 

• 2 ½-Element Wye 

Using Fluke Power Analyze 
In addition to analyzing data that has already been recorded, you can also 
connect to a Recorder through Power Analyze. When you do this, all of the 
features available through the PDA are also available directly on your PC. For 
example, you can: 

• View live data by connecting to a Recorder connected to power. 

• Configure a 1750 Power Recorder to which you are connected. 

• Add annotation markers and take manual snapshots that are then 
stored in the Recorder. 

Fluke Power Analyze software lets you work on your PC with power quality 
data monitored by and received from the Recorder. With Fluke Power 
Analyze, you can download, review, and analyze data. For example, you can: 

• Download data from a Recorder into a data file on your PC, or open a 
file that was downloaded previously and moved to your computer. 
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• Analyze the data you have downloaded using a series of views to see 
different aspects of it, including summary graphs of Volts/Amps/Hz, 
events, harmonics, THD, flicker, power and energy.  

As you review the data on the Power Analyze screens, you can adjust 
the data shown by turning on and off display of different channels and 
select other parameters. You can focus on the specifics that help you 
analyze and understand the power quality data. 

• See snapshots of the recorded power quality data at specific points in 
time as though you had looked at the measurements while they were 
live.  

Because snapshots are captured at regular intervals, you can advance 
through them and review the measurement as they were at successive 
points in time. 

• Build reports by tagging important data as you review it in Power 
Analyze, and then use the Power Analyze Report Writer to gather it 
into a report that includes images and details about the data.  

This section of the Getting Started Guide describes how to begin working with 
Power Analyze software to review and analyze data in recorded data files. Use 
it to become familiar with the Power Analyze interface and features. Detailed 
information for is available in the Power Analyze online help. 

Getting Answers to Questions as You Work 
As you work with Power Analyze, you can use Online Help to get detailed 
information about how to use the software to examine recorded data, connect 
to instruments and view live data, download data, and other tasks. You can 
access the online help system included in Power Analyze in several different 
ways.  

In the main window, click the Help question mark  on the toolbar and then 
click an item on the screen to get information about that item. You can use this 
to find information about buttons and other items on the toolbar, commands in 
menus, and the main screens.  

For information about the current view, or for help in a dialog box, click the 
Help button . You can also see this information by pressing the F1 key.  

You can also open the help system by choosing Help Topics from the Help 
menu.  
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Once Help is open, you can use the Contents, Index, and Search tabs on the 
left to help you locate information.  
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If the Help window is too wide, you can hide the navigation pane on the left by 
clicking the Hide button  at the top of the Help window. To open the 
navigation pane again, click Show .  

Starting Power Analyze 
You can start Power Analyze on your PC by choosing Start > All Programs > 
Fluke > Power Analyze > Launch Power Analyze. 

The first time you start Power Analyze, a sample file that was installed along 
with the software automatically opens. As you learn to use Power Analyze, 
you can use this file until you have a data file you want to analyze. 
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Note 

If the sample file does not open automatically, you may need to copy 
it from where you installed the software (normally, c:\Program 
Files\Fluke\Power Analyze) to the folder My Documents\PQ. You can 
then use the File > Open command to open it. This problem can occur 
if you do not have Windows Admin rights. 

Working with Recorded Data Files 
You work in the Fluke Power Analyze works with one file at time. When you 
download data, it is stored in a file with the extension ".odn". When you 
download using Power Analyze, these files are stored by default in the 
directory “\MyDocuments\PQ\”. If you move downloaded data from the 
Recorder to the PC via an SD card, you can copy the .odn file either to this PQ 
directory or to another folder. For information about moving downloaded data 
to your PC, see “Moving Downloaded Data from the Recorder to a PC” later in 
this manual  

To start Fluke Power Analyze and open a file at the same time 

1. In the Windows Explorer or on your desktop, locate the .odn file you 
want to open. 

2. Double-click the file to open the file in Fluke Power Analyze.  

To open a data file when Fluke Power Analyze is already open  

1. From the File menu, choose Open.  

2. In the Open dialog box, navigate to the file you want to open, select it 
and click Open.  

The file opens in a Fluke Power Analyze window and displays the 
Volts/Amps/Hz view. The name of the file appears in the application title bar. 
For details about the Power Analyze window, see “Overview of the Power 
Analyze Screen” later in this manual. 
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Moving Downloaded Data from the Recorder to 
a PC 
To analyze recorded data using Power Analyze. The procedure below 
describes how to download recorded data from the SD card to your PC to 
analyze recorded data using Power Analyze  

To move the downloaded data from an SD card to your PC 

1. Download the data from the Recorder’s internal flash memory to the 
SD storage card. 

2. Remove the SD storage card from the Recorder and insert into the top 
of the PDA, for easy transport. 

3. Place the PDA in a docking station connected to your PC. 

4. The SD card should display as a drive in the My Computer folder. 

5. On your PC, open the card as a drive.  

6. Copy the files from the PDA to the desired location on your 
computer.  

You are now ready to open the recorded data files in Fluke Power Analyze.  

Overview of the Power Analyze Screen 
Whether you are working with a recorded data file or are connected live to a 
Recorder, many of the elements of the Fluke Power Analyze screen are the 
same.  

Power quality data appears in the central screen area . The type of data you see 
depends on the active mode and view. Additional view controls on the right 
side and buttons on the tool bar let you customize how the data displays.  

Figure 3 shows the Volts/Amps/Hz recorded data view and Table 4 describes 
the areas and controls of the screen. For a detailed review of the contents of the 
actual data, see “Recorded Data Screen Overview” later in this manual. 
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Figure 3. Power Analyze Screen 
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Table 4. Power Analyze Screen Areas and Controls 

Number Description 

A Connected Recorder. When you are connected to a 1750 Power 
Recorder, this field shows its name. A drop-down list shows other 
Recorders to which you can connect. 

B Name of data file. When you view recorded data, the name of the 
".odn" file appears in the window title bar. 

C Help buttons. Several types of online help are available for Fluke 
Power Analyze. Two are shown on this screen. For details about 
accessing Help, see “Getting Answers to Questions as You Work” 
earlier in this manual. 

D Main Data Area. The central part of the screen shows the power 
quality data for the active mode and view. You can make further 
adjustments to the data displayed by using the view controls and 
tool bars. 

E View toolbar. Provides quick access to the different power quality 
data views for the active mode (Recorded Data, Snapshots, or 
Live 1750 Data). The active button on the View toolbar indicates 
the view you see now. 

F View controls. View controls specify what data to display in the 
view, and how it should appear. 

G Status Bar. Shows the power configuration, nominal voltage, and 
frequency for the data you are viewing. When viewing live data, it 
also shows the name of the Recorder.  

H Power Analyze Mode Side Bar. Mode buttons activate different 
sets of views and screens in Power Analyze. The active button 
indicates the mode in view. In the screenshot example, View 
Recorded is active. For more information, see “Overview of the 
Power Analyze Modes” later in this manual. 

I Main tool bar. Frequently used actions appear as buttons on the 
toolbar. 

J Menu bar. Menus provide access to Power Analyze commands. 
Frequently used menu items are also available on the main 
toolbar and view toolbars. 
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Overview of the Power Analyze Modes 
There are six modes in Fluke Power Analyze, all available 
from the side bar at the left of the screen. The top three 
allow you to work with recorded data that has been saved as 
a data file, while the bottom three let you work with live 
data when you are connected to a Recorder. 

Recorded Data Modes  

These modes are available when a recorded data file (.odn) 
is open.  

• View Recorded lets you analyze data that has been 
downloaded from a Recorder and saved as a data 
file.  

• View Snapshots displays snapshots of measured 
power conditions taken manually or on a periodic 
basis throughout the monitoring period and stored 
in the recorded data file.  

• View Settings displays the Recorder settings that 
were in effect when the recording was made. This 
includes power configuration, nominal voltage and 
frequency, voltage and current ratios, and other 
connection factors. 

 
Live Data Modes  

These modes are available when connected to a Power Recorder.  

• 1750 Setup lets you view and set the instrument settings, including 
the power configuration, nominal voltage and frequency, voltage and 
current ratios, and other details about the data that is recorded before 
starting a recording session. You can also create a password in this 
mode. 

• 1750 Live lets you monitor data directly, when you are connected to a 
Recorder. 

• 1750 Download lets you retrieve data from the Recorder and save it 
on your computer.  



1750 
Getting Started Guide 

30 

Recorded Data Screen Overview  
Recorded data views are the primary screens you work with when analyzing 
power quality data. Five different views of recorded data are available: 
Volts/Amps/Hz, Events, Harmonics, THD, and Power/Energy. Figure 4 shows 
a sample Recorded Data Screen and Table 5 describes the contents of the 
screen. 

In many of the recorded data views you see both a Reference graph and a 
Detail graph. When zoomed out, the reference graph shows the full range of 
available data. The detail graph shows a subset of that data. For more 
information about the screen menu and buttons, refer to the section “Overview 
of the Power Analyze Screen” earlier in this manual. 

When you work with recorded data, many of the elements on the screen are the 
same regardless of which view is displayed. 

Note 

Although a button for Flicker appears on the View toolbar, Flicker is 
not available in the first release of Fluke Power Analyze. Check the 
Fluke website (www.fluke.com) for updates. 
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Figure 4. Recorded Data Screen 
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Table 5. Recorded Data Screen Contents 

Number Description 

A Name of open data file. Shows the name of data file that is 
presently open. 

B Reference graph. Provides an overview of the data for the entire 
recorded period. 

C Detail graph. Shows a detailed view of a portion of the recorded 
data, determined by the selection cursors on the top graph.  

D Selection cursors. The selection cursor bars mark the data 
shown in the Detail graph. As you move the cursor bars, the data 
in the detail graph adjusts.  

E View toolbar. Lets you change between recorded data views. The 
active button indicates the view you see now. In the screenshot 
above, Volts/Amps/Hz is the active view.  

F View controls. Specify data to be displayed in the view, and how 
it should appear. For example, on the Volts/Amps/Hz graph shown 
above, view controls let you hide or show phases, select whether 
maximum values are shown, or show or hide annotations. 

G Status Bar. Shows the power configuration, nominal voltage, and 
frequency for the data you are viewing.  

H Measurement guides. This set of guides let you measure data in 
the Detail graph. The measurement value is shown on the boxed 
labels between the guides. 

I Graph toolbars. Provide access to tools you can use with graphs, 
such as showing and hiding the guides, or zooming in on data. 
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1750 Live View Screen Overview  
When you are connected to a Recorder, five different views of the live power 
conditions are available. You can see this same information using Fluke Power 
View on the PDA. Figure 5 shows a sample Live View Screen and Table 6 
describes the contents of the screen. 

Although the format of the 1750 Live views vary, the overall structure of the 
live screens is the same. The screenshot below shows the essential elements in 
the live Scope view. For more information about the Scope view and other 
1750 Live views, see the Online Help.  
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Figure 5. Live View Screen 
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Table 6. Live View Screen Contents 

Number Description 

A Connected recorder. Shows the name of the Recorder to which 
you are connected.  

B Main data area. Displays the power quality parameters you are 
viewing: Scope, PHASOR diagram, meter, harmonics, or power.  

C View toolbar. Lets you change between live views. The active 
button indicates the view you see now. In the screenshot above, 
Scope is active. 

D View controls. Specify what data to display in the view, and how 
it should appear. 

E Status bar. Shows the Recorder setup, including selected 
Recorder name, IP address, power configuration, nominal voltage, 
and frequency. You can set this information using the 1750 Setup 
mode, or using Power View on the PDA. For more information 
setting up a Recorder through Power Analyze, see the Online 
Help. 

Snapshot Screen Overview  
Snapshots are screen captures at a single point in time of the measurements 
made by the Recorder as displayed in 1750 Live mode. When you download 
data, you download snapshots (taken manually and at regular intervals), along 
with the long-term summary data and events. All five views that are available 
for live power are also available in the snapshot views, giving you a detailed 
view of conditions at specific intervals.  

When you first display the Snapshot views, you see the first snapshot taken in 
the downloaded data. You can use the Slider Bar or the Next/Previous buttons 
to bring additional snapshots into view.  

The interval at which snapshots are captured is specified when the Recorder is 
set up. In addition, a snapshot can be taken manually using the PDA or using 
the Take Snapshot button.  

Figure 6 shows the main elements in snapshot views. More detail on specific 
snapshot screen elements are described in Table 7. 
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Figure 6. Snapshot Screen 

Table 7. Snapshot Screen Contents 

Number Description 

A Data filename. Shows the name of the data file presently open. 

B Main data area. Displays a snapshot of the conditions at the date 
and time shown in slider bar. In this example, the snapshot is of 
the Scope for the phases checked in the Phase Selection area of 
the view controls. For details about the contents of the different 
snapshot views, see the Online Help.  

C Slider bar. Allows you to move to a snapshot at a different point in 
time within the recorded data by dragging the slider.  

D View toolbar. Lets you change to different Snapshot views: 
Scope, Phasor, Meter, Harmonics, and Power. The active button 
indicates the view you see now. 
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Table 7. Snapshot Screen Contents (cont.) 

Number Description 

E Next/Previous buttons. Lets you move through snapshots one at 
a time by clicking these buttons.  

F View controls. Specify data to be displayed in the view, and how 
it should appear.  

G Status bar. Shows the power configuration settings at the time the 
data was recorded.  

Working with Snapshots 
Snapshots are captured at regular intervals, based on the Snapshot Interval set 
in 1750 Setup. You can also capture snapshots manually using the Take 
Snapshot button on the Power Analyze toolbar in 1750 Live Mode, or using 
the wireless PDA with the Recorder. Snapshot data is saved in the Recorder 
and downloaded with the rest of recorded data. 

When viewing at Snapshot screens in Power Analyze, two tools are available 
to move through the available snapshots: 

• The Slider bar appears at the top of each Snapshot view.  
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Press and drag the slider bar to the point in time for which you want 
to see power conditions.  

The snapshot data closest to this point in time is shown in the 
Snapshot view.  

• The Next/Previous buttons  appear at the top of the View 
controls. 

Click these buttons to move to the next snapshot in either direction.  
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Main Toolbar 
The main toolbar in the Power Analyze window includes standard Windows 
tools and some specialized buttons for working with Fluke Power Analyze 
graphs. Figure 7 shows the Main Toolbar and Table 8 describes the contents of 
the toolbar. 

Hide or show the toolbar by choosing View > Toolbar.  

Note 

The tools on the main toolbar all have a corresponding topic on a 
menu.  
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Figure 7. Main Toolbar 

Table 8. Main Toolbar Contents 

Number Description 

A Open. Opens a recorded data file.  

B Top Full Screen View. Expands the top graph to fill the graph 
window area.  

C Bottom Full Screen View. Expands the lower graph to fill the 
graph window area.  

D Split Screen View. Displays a reference graph on the top and a 
details graph in the bottom of the graph window area.  

E Top Table View. Toggles the display of the data in the top 
reference graph from graph to table and then back.  

F Bottom Table View. Toggles the display of the data in the bottom 
detail graph from graph to table and then back.  
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Table 8. Main Toolbar Contents (cont.) 

Number Description 

G Take Snapshot. Takes a snapshot of the current power 
measurements. Available only in 1750 Live views. 

H Insert Annotation. Inserts an annotation marker. Available only in 
1750 Live views 

I Help. Lets you get information about buttons on the screen and 
commands in the menus. Click the Help tool button and then the 
item you want information about. For information about the 
contents of the main graph area, click the Help button at the top of 
the Graph controls on the right side.  

J Window List. Lets you switch between multiple windows in the 
same recorded data file.  

Graph Toolbars 
When you view data on graphs, special toolbars are available to help you work 
with that data. Figure 8 shows a sample Graph Toolbar and Table 5 describes 
the contents of the toolbar. 

The particular tools available vary depending on the contents of the graph. The 
screenshot below shows some of the tools that appear on graph toolbars, and 
more detailed information about specific features follows that. 

 
bae105s.bmp 

Figure 8. Graph Toolbar 
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Table 9. Graph Toolbar Contents 

Number Description 

A Zoom All the Way Out. Zooms out to display the full graph. 
Active only after you have zoomed in on a portion of a graph.  

B Zoom Out. Zooms out on the graph keeping the same graph 
center. 

C Zoom In. Zooms in on the graph keeping the same graph center.  

D Select. Lets you select annotation markers in graphs on the 
Volts/Amps/Hz view and the Events view. When you select this 
tool Zoom becomes inactive. 

E Guide. Shows or Hides the guides on a graph. 

F Copy. Copies the current graph to the Clipboard. 

Zooming In and Out On Graphs 
Sometimes the amount of data shown on a graph makes it hard to clearly see 
the detail you need to analyze power quality data. When this is the case, you 
can zoom the graph to magnify your view of the data. A combination of 
zooming and scrolling can often be used to focus on the specific information 
you need.  

Several zooming tools are available: the Zoom Box and Zoom In/Zoom Out 
buttons on the graph toolbar, and the Zoom to Fit command on the right-click 
menu (available when you point to either the horizontal or vertical axis).  

To zoom in and out incrementally: 

• In the graph toolbar, click the Zoom In  and Zoom Out  
buttons.  

To zoom in on a section of a graph with the Zoom box:  

1. If it is not already active, click the Zoom Box tool . 

2. Draw over the section of the graph you want to see in more detail. 

Fluke Power Analyze zooms in on the area you marked and centers it 
in the window. 
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The selection cursors on the Reference Graph shift to mark the new 
selection.  

3. If the information you want is not quite centered, you can scroll the 
graph horizontally or vertically.  

Note 

You can zoom in multiple times on an area of a graph. If the graph 
area appears blank, you may have zoomed outside the range of data.  

To zoom out 

• If you want to zoom out incrementally, click the Zoom Out button 

.  

• If you want to zoom back to 100% size, click the Zoom All the Way 
Out button . 

To use Zoom to Fit: 

You can automatically zoom the available data to the size of the graph window 
by using Zoom to Fit.  

You can Zoom to Fit based on either the Y-axis or the X-axis:  

1. Right-click on the axis you want to resize. 

2. Choose Zoom to Fit from the right-click menu. 

The available data zooms to the size of the window, based on the axis 
where you right-clicked. If appropriate, the axis will adjust to match 
the range of data.  

In the Harmonics and THD views, using Zoom to Fit on the x-axis of 
the Harmonics Spectrum graph will display all 50 harmonics in the 
graph window at once. 
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Screen View Tools 
When you first view recorded data, the views show two types of data in a split 
view format. Figure 9 shows a sample Screen View Tools  and Table 10 
describes the tools. 

For most views, the data includes reference data, which gives a broad view of 
the recorded data, and detail data in the display’s top half, which appears in the 
bottom half of the display.  

Options on the left toolbar let you expand either set of data to fill the window. 

Note 

 This feature also works when you are displaying as a table either the 
top or bottom set of data. 
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Figure 9. Screen View Tools 

Table 10. Screen View Tools 

Number Description 

A Click to see the top full screen view. 

B Click to see the bottom full screen view. 

C Click see both graphs again. 

Viewing Data as a Table 
In most recorded data views, you can view data in table format as well as in 
graph format. This is useful for studying results in the form of digital readings, 
or preparing tabular data for a report. 

When you switch to the table display, the tables generated remain on the 
screen even as you change recorded data views, until you turn off the table 
display and switch back to graphs.  
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Note  

If you click the Tag for Report button when a table is in view, the 
portion of the table in view will be included in your next report. (For 
more information, see “Building a Report” later in this manual.) To 
print all of the data in the table, first export it to a spreadsheet.  

To toggle between graph and table views: 

You can toggle between graph and table views for the top graph, the bottom 
graph, or both graphs.  

• Click one of the Table tools  to display the upper or lower 
graph as a table. 

• Click the Table tool again to return to the graph display shown in 
Figure 10.  
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Figure 10. Graph Display 

To sort the data in a table: 

• When you view Events in a table, you can sort the tables by clicking 
the header for the column you want to sort by.  

To maximize a table to full size: 

• Click the Top Full View button or the Bottom Full View  
button , depending on which table you want to view full size. 
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Working with Annotations 
Annotations are optional markers that can be inserted by the Recorder operator 
to flag a particular point in the data when recording. They are usually inserted 
on using Power View with the wireless PDA. Figure 11 shows a sample 
Annotation View screen. 

Annotations can be used to help select what data to download, and to provide 
additional information when reviewing recorded data in the Volts/Amps/Hz 
view.  
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Figure 11. Annotation View 
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There are five types of annotations:  

• Start annotation (green) 

The Start annotation can be used to signify where important data 
begins. For example, the operator might want to establish a start 
annotation after having finished all probe connections and instrument 
setup, to indicate that any preceding data was preliminary.  

Note 

You are not limited to using the Start and Stop annotations in pairs, 
or to show a range of data. You can use each as many times as 
desired to mark a particular point during recording.  

• Stop annotation (red)  

The Stop annotation can be used to signify where important data 
ends. 

• File annotation (yellow) 

File annotations contain the name of a picture or audio file relevant to 
the data. See “Using Image or Voice Annotations” later in this 
manual. 

• Text annotation  

Text annotations contain a text note.  

• Power Configuration Change annotation  

Power Configuration Change annotations are inserted by the system 
when a change is made to the Power Configuration in the Recorder. 
These markers only display in the Download dialog box. 

To show or hide annotation markers  

• In the Volts/Amps/Hz or Events view, check or uncheck the 
Annotations option on the view controls. 

To open an annotation 

• In the Volts/Amps/Hz view, Events view, or Download dialog box, 
click on the annotation.  

If the annotation is associated with an audio (.WAV) or image (.jpg) 
file, the application associated with that file will start and open the 
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file. If the file is not in the default directory My Documents\PQ, a 
dialog box opens so that you can navigate to the file. 

Note 

If clicking on an annotation marker does not seem to do anything, the 
Zoom box is probably selected in the graph toolbar, instead of the 
Select tool. Click the Select tool and then select the annotation. 

To see overlapping annotations 

Sometimes annotations are so close to each other that they actually overlap on 
the Volts/Amps/Hz reference graph. When this is the case, if you click on 
overlapping annotations, a menu opens and you can select either Open, to open 
the annotation now on top, or Select Next Overlapping Annotation, to bring 
the next one to the top.  

• To open the annotation now on top, choose Open. 

• To bring the next annotation to the top, choose Select Next 
Overlapping Annotation. To then open that annotation, click on it 
again and choose Open. 

Note 

To see overlapping annotations more clearly on the Volts/Amps/Hz 
reference graph, move the selection cursors so that they just surround 
the area that contains the overlapping illustrations. The Detail graph 
adjusts as the cursors move, zooming in to show the area between the 
selection cursors. You can now see the annotations separately.  

Using Image or Voice Annotations 

While you are monitoring data with a Recorder, you may find it helpful to take 
a picture that relates to the power quality data you are recording, or to record 
verbal comments as you observe the conditions or review the data being 
measured. You can then associate the image or recording with the data being 
recorded by adding annotations that reference them.  

The PDA includes a microphone for recording notes which are saved as .WAV 
files, and an optional camera accessory is available on the PDA which will 
capture images as .jpg files.  
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You can associate both images and audio files with the data being gathered in 
the Recorder by inserting annotations and specifying the name of a .WAV or 
.jpg file. After you download data from the Recorder, you can then move the 
image and audio files to the PC along with the recorded data (.odn) file.  

Note 

You can also associate other types of files with the annotation. For 
example, if you had a .MPJ file with a movie, or a .DOC file with 
associated information. You can enter any file name using this 
annotation method. 

Inserting Image or Voice Annotations  

1. Set up the Recorder and begin monitoring. 

2. Using your PDA-cam or another camera, take a picture of what you 
want to capture. 

3. In Power Analyze, go to 1750 Live mode and click the Annotate 
button  to open the Annotate dialog box.  

Or on your PDA, in Power View, click the Annotate icon to display 
the Annotate screen.  

4. Select Insert File. 

5. Browse to find the picture file (for example, IMG_2435.jpg ) or audio 
file (for example, voice_123.wav) and select it; then click Insert.  

The file name you specified is inserted into the data and associated 
with the present date and time (and therefore, the present power 
measurements).  

Managing Image and Voice Files 
If you are using the PDA, move the image or audio file to a location that will 
make it easier to Transfer it to a PC later, when you download and move the 
recorded data file to your PC. You can accomplish this in two ways:  

• Place the file into the synchronization folder on your PDA, so 
that it will be automatically transferred into the sync folder on the 
PC the next time you dock the PDA. 
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You may find this approach useful if you download data using 
Power Analyze on your PC. After synching the files from your 
PDA, be sure to move the annotation files into the folder that 
contains your .odn files (by default, \My Documents\PQ). 

• Transfer the file onto an SD card for later transfer to your PC.  

If you use the PDA to download data to an SD card, copying the 
audio or image files to the SD card may be the easiest method; 
then you can copy all associated files to your PC at once. Be sure 
to copy the files into the same folder that contains the 
downloaded .odn file.  

Building a Report 
You can build a report by tagging specific data you see on the screen in the 
View Recorded and Snapshot modes. You can tag as many different views as 
you want before creating the report. Power Analyze remembers what you have 
tagged until you exit the application, or until you generate a report. If you tag 
more than you need, it is easy to delete tagged items from the report later.  

Note 

To make use of the reporting feature in Power Analyze, you must have 
Microsoft Word 2000 or later installed on your computer.  

To include data in a report 

1. Get the screen to look just the way you want. 

Power Analyze will capture the contents of the main area just as you 
see it. Use any of the tools — view controls, zoom features, split/full 
screen, and so forth — to adjust the display. 

2. Click the Tag for Report button at the bottom of the view controls. 

3. In the dialog box that displays, enter a heading to identify the data. 

This heading will appear in your report. By default, Power Analyze 
inserts the name of the active view. You can change this heading to 
be more specific.  

4. Click OK. 
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5. Continue working, tagging additional screens when you want to 
include them.  

To create the report 

1. When you are ready to create the report, choose File>Report Writer. 

A dialog box lists the items you have tagged.  

2. Enter a name for the report and click OK. 

If you want to create the report in a particular location, before you 
click OK, click the Browse button, navigate to the appropriate folder, 
and click Open. 

After you click OK, Microsoft Word opens, displaying the screens 
you tagged. In addition, details about the data are included, such as 
what channels and phases are displayed, and other criteria selected 
with the View controls.  

Note 

To append to an existing report, click Browse and select the report 
file to which you want to append. The new data you have tagged will 
be added to the end of the existing report file. (The existing report file 
must be closed when you select it; it cannot already be open. 

3. You can add additional information to the Word document, to 
customize your report.  
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1750 
Power Recorder 

Introduction 
The Fluke 1750 Power Recorder is a comprehensive yet easy to use system for power 
quality investigations. The 1750 Power Recorder, referred to hereafter as simply “the 
Recorder”, consists of a power recorder instrument, a wireless handheld Personal Digital 
Assistant (PDA) for control and setup, and a powerful yet easy to use PC application, 
Power Analyze. Four 400 A current probes are provided as standard equipment. A wide 
range of flexible and clamp-on current probes are available from Fluke. 
Key features of the 1750 Power Recorder are: 
• No PC needed for setup 

Using the included a wireless-enabled Personal Digital Assistant (PDA) as a 
controller, you do not need a PC to configure the Recorder, troubleshoot connections, 
preview data, or download the recorded data. Downloaded data goes onto the SD 
memory card plugged into the 1750, not directly to the PDA. The range of the PDA 
with the wireless link is about 15 meters (45 feet) from the Recorder. 

• Simplified test lead connections to the power network 
Simply connect a voltage probe to a conductor on each phase that you want to record. 
On the current inputs, the Recorder automatically identifies what type of probe is 
connected. The Recorder then configures its measurement system appropriately for 
the model of current probe you are using.  

• Connection diagrams for the supported power network configurations (delta, Wye, 
and others) appear on the handheld PDA controller. Once you make connections, you 
can view live readings and a phasor diagram on the PDA to confirm the connections. 
If a phase channel is wired incorrectly, you can swap the phase to another channel by 
changing an internal Recorder setting using the PDA, and then reconfirm correct 
readings. 

• Internal Uninterruptible Power Supply (UPS) 
An internal NiMH (Nickel-Metal-Hydride) battery pack and charging system 
maintain data capture continuity through power interruptions of 5 minutes or less. 

• Automatic disturbance capture 
The Recorder uses an automatic, self-learning threshold routine, which means you do 
not have to set any event threshold limits before you start recording. You detect and 
display power quality events (disturbances) using the Power Analyze software on a 
PC after the event has been captured.  
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You define thresholds for events after data is stored on the PC. This is called the "event 
detector" in the software. It does not make permanent changes to the data file, so you can 
experiment with different thresholds after the fact without worrying about losing data. 
With these features, there is little else required to set up and start recording the data to 
conduct a power quality survey. Should you want to extensively analyze collected data, 
the procedures described later in this manual review the transfer of data from the 
Recorder to the PDA, and finally to a PC. Data may then be analyzed using Power 
Analyze on a PC. Extensive online help is provided in the Power Analyze software on the 
product CD shipped with the Recorder. 

Contacting Fluke 
To contact Fluke, call: 
1-888-993-5853 in USA  
1-800-363-5853 in Canada 
+31-402-675-200 in Europe 
+81-3-3434-0181 in Japan 
+65-738-5655 in Singapore 
+1-425-446-5500 from anywhere in the world 
Or, visit Fluke’s Web site at www.fluke.com 
To register your product, visit register.fluke.com 
To contact Technical Support: 
fpqsupport@fluke.com or 888-257-9897 
 

http://register.fluke.com
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Safety Information 
The Recorder complies with EN 61010-1 600 V CAT IV, 1000 V CAT III overvoltage 
rating. See the Specifications section for a full agency compliance list. 

XWWarning 
To avoid electrical shock or fire: 

•  Review the entire manual before using the Recorder and its 
accessories and observe all warnings and cautions. 

•  Avoid working alone. 

•  Do not operate the Recorder around explosive gas or vapor. 

•  Use only insulated current probes, test leads, and adapters as 
supplied with the Recorder, or indicated as suitable for the 
Recorder. 

•  Before use, inspect the Recorder, voltage probes, current probes, 
leads, and accessories for mechanical damage, and replace when 
damaged. Look for cracks or missing plastic. Pay special 
attention to the insulation surrounding the connectors. 

•  Remove all probes, test leads, and accessories that are not in use. 

•  Make sure the Recorder is properly connected through the power 
cord to protective earth ground. 

•  Do not apply input voltages above the rating of the Recorder as 
shown on the input panel. 

•  Do not apply voltages in excess of the marked ratings of the 
voltage probes and current probes. 

•  Do not use exposed metal BNC or banana plug connectors. 

•  Do not insert metal objects into connectors. 

•  Never open the Recorder’s enclosure, dangerous voltages are 
present. There are no user replaceable parts in the Recorder. 
Refer servicing of internal parts to qualified service personnel 

•  Use the Recorder only as specified in this manual, or the protection 
provided by the Recorder may be impaired. 
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Table 1. Symbols 

X Hazardous voltage. Risk of electrical 
shock. Precedes Warning 

W Risk of danger. Important information. See 
manual. Precedes Caution and Warning. 

P 
Conforms to requirements of European 
Union and European Free Trade 
Association (EFTA). 

~ 
Do not dispose of this product as unsorted 
municipal waste. Contact Fluke or a 
qualified recycler for disposal. 

) Canadian Standards Association. [ Note: 
Canadian and US. ] 

J Protective conductor terminal. 

CAT III 

CAT III equipment is designed to protect 
against transients in equipment in fixed-
equipment installations, such as 
distribution panels, feeders and short 
branch circuits, and lighting systems in 
large buildings. 

CAT IV

CAT IV equipment is designed to protect 
against transients from the primary supply 
level, such as an electricity meter or an 
overhead or underground utility service. 

Accessories 
Table 2 describes the standard accessories that ship with the Recorder. 

Table 2. Standard Accessories 

Description Part Number 

Ethernet cable, 3 meters, yellow 2402854 

Colored plastic clips for test leads (32 clips, 8 colors, 4 clips each color) 2157607 

Model TLS430, test lead set including cable and clips  2157713 

512MB Secure Digital (SD) Memory Card for downloading data 2386744 

Model 3140R, 400 A Clamps (3) 2277216 

AC power cord, 3 meters 2441360 

Personal Digital Assistant (PDA) with docking station 2386780 

CD ROM Manuals and Software 2386771 

1750 Getting Started Guide 2386767 

Sheet of Front Panel Decals 2436261 

Sets of international ac power plug adapters for the PDA charger  2583479 

International adapters for the Recorder power cord 2441372 
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You can also order the following optional accessories. For more information about 
accessories, see Contacting Fluke earlier in this manual. An updated list is always 
available on www.fluke.com. 
• Soft Carry Bag 
• Hard Transit Case 
• Security Cable 
• Mounting Bracket 
• Replacement Ethernet Cable Kit 
• Various Current Probes 

3601 Crocodile Clip 
3602 Battery Clip 
3605 Stud Type 
3606 Screw Type 
3607 Bus Bar 
3608 Plunger Type 
3641 In-Line Fuse  

• Replacement Voltage Lead Set 
• Clamp-on Current Transformers (3005R) 
• Flexible Current Transformers (3110, 3210, 3310, 3312) 
• Split-Core Current Transformers (3583R, 3584R, 3585R) 

• Interface and Extension Cables 
3570 CT Cable 
3533 Pod Adapter 
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Features 
The Recorder front panel is illustrated in Figure 1 and described in Table 3. 

SD

ETHERNET

POWER

1750 POWER RECORDER

ON

BUSYLINK

100-240 V
  47-63Hz

BA C N

VOLTAGE

CURRENT

4

13

1

2 3

11 10 812

7

5

6

9

 
azd09f.eps 

Figure 0-1. Fluke 1750 Power Recorder 

WCaution 
Connecting the supplemental ground terminal and the line cord 
safety ground to different ground potentials creates a ground 
loop that can damage the Recorder. 
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Table 3. Input Terminals and Controls 

Number Description 

A Standard 120/240 V 50/60 Hz power input for Recorder power 

B Voltage indicator 
Steady   Voltage is present, not overloaded 
Blinking   Voltage overload (overload threshold 1100 V) 

C Five voltage measurement inputs 

D Removable Secure Digital (SD) memory card for transfer of large quantities of data. You can 
remove the card from the Recorder, insert in the PDA and transfer data to the PC via the 
“synchronize data” feature of the PDA. 

E SD status indicator 
Steady green SD card inserted 
Blinking   Busy - do not remove the card 

F Wireless Controller Status Indicator 
Steady Blue  Wireless controller enabled but not communicating 
Blinking   Wireless controller communicating 
Off    Disabled 

G Ethernet port. TCP/IP via Ethernet is used to connect the Recorder to a PC for downloading 
recorded data, and for configuring the Recorder when not using the PDA. 

H Busy Indicator 
Blinking   Network is busy 

I Link indicator 
Off    No link 
Steady   Link Present 
Blinking   Communicating (with PDA or PC) 

J Current Measurement Terminals (5) 

K Current indicator 
Steady   Current probe in normal range 
Blinking   > 110% of probe range, use a higher range probe 
Off    Current insufficient to measure 

L Red/Green LED 
Steady green  AC input power normal 
Green/Red blinking Recording 
Blinking red   Recorder running on UPS 

M Ground Terminal  
Connecting the supplemental ground terminal and the line cord safety ground to different 
ground potentials creates a ground loop that can damage the Recorder. To avoid this, use the 
supplemental ground terminal only when no protective earth ground connection exists through 
the line power cord. If there is any chance that a safety ground connection does exist through 
the line power cord connection, make sure to connect the supplemental ground terminal only to 
the ground system used by the ac receptacle that powers the Recorder. See Figure 3. 
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Applying the Front Panel Decal 
Self-adhesive front panel decals are supplied with the 1750. The supplied decals 
correspond to the wiring color codes used in the USA, Europe and UK (new), Europe 
(old), UK, Canada, and China. Apply the decal appropriate for your local wiring codes 
around the current and voltage inputs as shown in Figure 2. 

EUROPE & UK (new std)

L2L2L1L1 N

VOLTAGE

CURRENT

China

BA C NN

VOLTAGE

CURRENT

EU (old std)

L2L2L1L1 L3

L3

N

VOLTAGE

CURRENT

UK

L2L1 L3 N

VOLTAGE

CURRENT

USA

BA C N

VOLTAGE

CURRENT

Canada

CURRENT

BA C N

VOLTAGE

SD

ETHERNET

POWER

1750 POWER RECORDER

ON

BUSYLINK

100-240 V
  47-63Hz

BA C N

VOLTAGE

CURRENT

 
azd17f.eps 

Figure 2. Applying the Front Panel Decal 



 Power Recorder 
 Applying the Front Panel Decal  

  9 

WCaution 
Connecting the supplemental ground terminal and the line cord 
safety ground to different ground potentials creates a ground 
loop that can damage the Recorder. 

Potential
Ground
Loop

Correct,
No Ground Loop

Optional Protective
Chassis Ground

(See detail below)

Different Power System

OK

Line Power Cord

Power Network Being Measured

See     Caution Above

Incorrect,
Creates Ground Loop

GND

N

ØC

ØB

ØA

 
azd11f.eps 

Figure 3. Connecting the Supplemental Ground Terminal 
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Charging the PDA Battery 
Your PDA is shipped with a discharged or partially charged, rechargeable battery. You 
should fully charge the battery before setting up the device, and recharge it regularly. 
Refer to your PDA user’s guide for detailed information about the battery. 

WCaution 
Do not leave important data on the PDA. If the battery 
discharges completely, you will lose all data not stored in File 
Store (ROM). Discharging the battery completely is similar to 
performing a hard reset. Refer to the PDA user’s manual for 
more information. 

Installing the Software 
This section describes how to install Fluke Power View software on the PDA and Fluke 
Power Analyze software on your PC. Keep your product CD in case you need to reinstall 
the software in the future. You should periodically check the Fluke website: 
www.fluke.com to see if any 1750 firmware or application software updates are available 
for download. 

Installing Power View on the PDA 
1. Insert the CD that ships with your PDA in your PC. Follow the on-screen instructions 

to install the ActiveSync software that allows your PC to communicate with the 
PDA.  

2. Put the PDA in the docking station and establish a partnership between the PDA and 
your PC. This can be a "Guest" or "Standard” partnership. 

3. Insert the CD that ships with your Recorder in the CD-ROM drive on your PC. 
4. A window appears that lists options on the CD. If the install software window does 

not automatically appear, do the following: 
5. On the Windows taskbar, select Start, then Run. 
6. Type d:\loader.exe (where d: is your CD drive letter). 
7. Select Install Software. 
8. Select Install Fluke Power View. 
9. Power View will be installed in the Programs folder on the PDA. 
10. To start Power View select Start, and then Programs on the PDA. Tap the Power 

View icon  to start using the application. 

PC System Requirement for Power Analyze 
• Windows 2000 Professional at minimum, Windows XP or higher recommended. 

Administrator privileges are required to install software on Windows 2000 or XP. 
• PC with 300 MHz or higher processor clock speed, Intel Pentium/Celeron family, or 

AMD Athlon/Duron family, or better.  
• Processor Recommended: 1 GHz or higher, Pentium 4, AMD Athlon, or better. 
• 256MB RAM (1GB recommended). 
• 1024 x 768 or higher resolution video. 
• Keyboard and mouse. 
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Installing Power Analyze  
Before installing the software on your PC, make sure you have Internet Explorer version 
5.01, or later appropriate to the language or culture settings of the operating system 
installed on your computer.  

WCaution 
Do not remove the CD until after you have successfully 
installed the software, rebooted the machine, and opened the 
application. 

1. Insert the CD into your CD-ROM drive. 
2. A window appears that lists options on the CD. If the window does not automatically 

appear 
3. On the Windows taskbar, select Start, then Run. 
4. Type d:\loader.exe (where d: is your CD drive letter). 
5. Select Install Software. 
6. Select Install Fluke Power Analyze. 
7. Follow the installation instructions that appear. After software installation is 

complete, the Power Analyze icon  appears on your desktop. 
8. Start Power Analyze on your PC by choosing Start > All Programs > Fluke > Power 

Analyze > Launch Power Analyze or double-click the Power Analyze icon  on 
your desktop. 

9. After the installation is complete, please take a few minutes to complete your product 
registration. You can register quickly online (preferred) at http://register.fluke.com or 
you can print the form and fax it to the number provided on the form. Product 
registration is very important since it allows you to get free software updates and 
helps us provide you with the fastest and most efficient technical support.  

Note 
When Windows XP Service Pack 2 is installed on your PC, Power Analyze 
can no longer browse for 1750 Power Recorders. This occurs because 
Service Pack 2 installs a firewall that does permit Power Analyze to receive 
browse data. You may need to change your Windows firewall settings to 
allow the program FPA.exe to use ports 18571 (TCP) and 18572 (UDP). 
For more on changing firewall settings, refer to 
http://support.microsoft.com.  

Installing the Power Recorder at a Facility 
This section describes the steps you need to take to set up the Recorder at a facility and begin a 
recording session. 

Work Flow 
There are three distinct stages for a recording session. 
• Set-up  

Set-up, hookup, and verification of connections and measured signals. This is when 
you will want to clear the Recorder memory (not required, but good practice because 
data download when finished only contains your new data), make any desired 
Recorder setting changes, and insert annotations and/or an optional START mark 
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into the recorded data stream. Annotations are messages or notes you insert into the 
data stream during a recording session. 

• Interim checkup, mid-recording session 
At this time, you may want to re-check all the live input signals, and download the 
data recorded since the beginning of the recording session. This does not interfere 
with ongoing recording in any way. Annotation capability is always available during 
the recording session. 

• End of recording session 
You can re-verify if desired, correctness of live data and then download data, power 
off the Recorder, and pack up for transport. 

Installing the Recorder 
To install the Recorder at a facility, follow the basic steps below.  
1. Position the Recorder within 2 m (6 ft) of the monitoring location. 
2. The Recorder can be set on the floor or a table, or attached and secured to a pole or 

other mounting surface. The Recorder can be oriented vertically or horizontally. 
3. Connect the Recorder to a 100 to 240 V ac power source, 50 or 60 Hz. 

• Connect the power cord to the Recorder using the appropriate supplied 
adapter. 

• Connect the power cord to a properly grounded wall outlet. 

WCaution 
• Ground the chassis before you do anything else. 

• Be sure to plug the power cord into the Recorder panel 
BEFORE connecting it to an outlet 

4. Plug the power cord into a properly grounded wall outlet. 
5. Turn on the PDA and tap the Power View icon  to launch Power View. 
6. If a Recorder is within range and is not password protected, the Home screen for live 

data appears. 
7. If more than one Recorder is within range, select one Recorder for use. 
8. If you have previously established password protection for the Recorder using the 

Power Analyze PC software, you must type the correct password in the Password text 
box and tap the Enter button. (Password protection is established for a specific 
Recorder using either the Setup Password menu in Power View or the Power Analyze 
software). 

9. All LEDs should flash ON, then OFF, and then each should turn ON and OFF in 
sequence. The LEDs will then remain on if you make secure test lead connections 
and there is sufficient voltage and current. 

Connecting the Recorder to the Wiring 
After you have set up the Recorder you are ready to connect the voltage leads and current 
probes or flexi-probes to the power network to be tested. Refer to the Power Type 
diagrams provided on the PDA or in the 1750 Operators Manual. 
In most cases, you should install the current probes first. Because they are clamped 
around wires, current probes are usually more secure than voltage probes. Examine the 



 Power Recorder 
 Installing the Power Recorder at a Facility  

  13 

conductors you are about to connect to and determine if you should attach the current 
probes to the phase wires or busbars before you connect the voltage probes.  
1. Select and attach the appropriate current probes to the Recorder. 
2. Select and attach the appropriate voltage test leads and probes to the Recorder. 

Note 
If your power connections require potential transformers (PTs) or current 
transformers (CTs), you can use the ratio settings in Power View to set the 
Recorder to display readings as they exist on the primary side of the PT and 
CT (for example, 12000 V). 

3. Connect the Recorder to the wiring by first connecting the measurement ground test 
lead to the distribution system ground, and then the neutral probe to neutral. 

4. Connect the ground current probe to the distribution system ground and the neutral 
current probe to neutral, with the arrow on the current probe pointing towards the 
load (away from the source) in each case. 

5. Connect the remaining current probes to the power network.  
• The arrow on the current probe should point toward the load. 
• Use the color-coding on the leads to help you connect the probes to the correct 

phases, neutral and ground.  
6. Connect the remaining voltage probes. 

Note 
Make sure the voltage probes and current probes are paired correctly , 
Phase A (L1) voltage to Phase A (L1) current and so forth. Calculations are 
made in pairs and cannot be changed after data is recorded. The leads for 
the voltage probe and current probe of the same color should be attached 
to the same phase wire or busbar. 

7. Check the LED for each phase to make sure a connection is established.  
• When a phase LED is ON or lighted, you know that the connection is active and 

that voltage and current is within the normal range.  
• When a phase LED is BLINKING, you are connected but the voltage or current 

is exceeding the normal range or exceeding the range of the probe that you are 
using. 

• When a current LED is OFF or unlit, there is insufficient current present in the 
line. 

Verifying Your Connection 
Before you leave the Recorder to accumulate data at the facility, double-check the 
connections.  
• Make sure the current probes are secured and completely closed around the 

conductors and that the voltage and current LEDs are steady-on. 
• Use the PHASOR screen on the PDA to verify that the voltage and current 

connections are correct. You can swap the connections using Power View if they are 
incorrect. 



1750 
Operators Manual 

14 

Finishing UP 
After making any corrections to the connections, recheck the phasor diagrams to confirm 
your connection. Make sure the nominal voltage, nominal line frequency, and power type 
(delta, wye, other) are correct before you leave the Recorder. It is a good practice to 
insert a START Mark when you are finished with all settings so you can download data 
and ignore useless readings and events common at the beginning probe connecting 
activities. 

Managing Recorded Data 
Recorded data resides in the Recorder on an internal non-physically accessible flash 
memory circuit. It is not transferred to an SD memory card in the Recorder’s SD memory 
slot until you request a download action using the PDA or an attached PC. 
It is never technically necessary to erase internal memory. When the Recorder has new 
data to record, it does so automatically, overwriting the oldest data. You can erase 
internal memory for security reasons, or if you want to simplify what you will be seeing 
in the download data screen. The start and end times will represent one recording session 
when old data is erased. 

Note  
Data is not removed from internal Recorder memory until you erase it 
using Power View software on the PDA or Power Analyze software on your 
PC. 

Power Type Diagrams 
The wiring illustrations included cover the standard power configurations that are 
selectable in Power View or Power Analyze software. The diagrams are provided as an 
aid in making the correct test lead connections. Power type diagrams are also included on 
your PDA and can be referenced when you are setting up nominal power on the 
Recorder. 
Available power type settings are: 
• One-Phase Plus Neutral (Figure 4) 
• One-Phase IT No Neutral (Figure 5) 
• One-Phase-Split Phase (Figure 6) 
• Three-Phase Wye (Figure 7) 
• Three-Phase Delta (Figure 8) 
• Three-Phase IT (Figure 9) 
• Three-Phase High Leg (Figure 10) 
• Three-Phase Open Leg (Figure 11) 
• 2-Element Delta (Figure 12) 
• 2 ½-Element Wye (Figure 13) 
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Figure 4. One Phase Plus Neutral 

Example: Branch circuit at an outlet. 
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Figure 5. One-Phase IT No Neutral 

Example: Used in Norway and in some hospitals. This would be the connection at a 
branch circuit. 
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Figure 6. One-Phase Split Phase 

Example: A North American residential installation at the service entrance. 
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Figure 7. Three-Phase Wye 

Example: Also called “Star” or four-wire connection. Typical commercial building 
power. 
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Figure 8. Three-Phase Delta 

Example: Often found in industrial settings where electric motors are used. 
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Figure 9. Three-Phase IT 

Example: Industrial power in countries that use the IT (Isolated Terra) system, such as 
Norway. 
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Figure 10. Three-Phase High Leg 

Example: A way to get a 120 V single phase feed by tapping across part of a leg in a delta 
power system 
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Figure 11. Three-Phase Open Leg 

Example: A variant of power transformer winding type. 
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Figure 12. 2-Element Delta 

Example: Blondel or Aron connection, used to measure power like a two-element 
revenue power meter. 
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Figure 13. 2 ½-Element Wye 

Example: Blondel or Aron system for a 4-wire (Wye) power secondaries. 
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Communicating with the Recorder Using Power View 
The PDA serves as your control panel for the Recorder. The Power View software 
installed on the PDA is designed to function as a remote front panel for the Recorder, 
since the Recorder itself is a “black box” with no integral display or external controls 
other than status LEDs. With Power View installed on the PDA, you are relieved of the 
burden of having to carry a laptop and Ethernet cable to a remote site when setting up the 
Recorder, checking its progress, or finishing a monitoring session. 
You can alternatively connect to a Recorder from a PC directly using an Ethernet cable or 
remotely over an IP network. You can then use Fluke Power Analyze to set up the 
Recorder, view power measurements wherever the Recorder is installed, or download 
data from the Recorder. 
Power View communicates with the PDA using a wireless controller radio interface. 
There is no provision for a hardwired PDA interface to the Ethernet port on the Recorder. 
After data is recorded and downloaded to a PC, you can analyze the recorded data using 
the Power Analyze software. 

PDA with
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Direct Ethernet Connection

Configure via RF
Communication

Fluke 1750
Power Recorder

PC with Power
Analyze Software

SD Flash
Memory

Card
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Figure 14. Connecting to the Recorder 
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Navigating in Power View on the PDA 
The Menu Bar on the bottom of the Power View screen allows you to quickly and easily 
configure a Recorder, view live data, and transfer data to the Secure Data (SD) card for 
viewing and analysis on your desktop computer using the companion Power Analyze 
software.  

Power View Menus 
Data  
Brings up the memory management screens which are for download to the SD card 
inserted in the Recorder and for erasing Recorder internal memory and erasing SD card 
files. 
View  
Brings up a list of the live detail views: Scope, Meter, Phasor, Harmonics, and Trend. 
There are configurable detail views of each type of screen available by tapping the sector 
of interest or the View menu. Once a detail view is selected, navigation to all available 
detail views is accomplished using the View menu. 
Setup  
Brings up the Recorder Setup menu, which allows you to configure the Recorder and set 
recording period information. Using this function, you can tap the appropriate icon to set 
the following : 
• Clock 
• Nominal Volts 

Nominal voltage and frequency values are auto-detected by the Recorder and shown 
as the defaults. These settings can be overwritten, forcing the Recorder to change its 
internal configuration to optimize power quality data recording for custom settings. 

• Volts and Current Scale 
• Passwords 
• Power Type Diagrams 
• Phase Swap 
• Probe Detect 

Icons on the Menu Bar 

   
Toggles between voltage and current waveforms. The PHASOR screen always shows 
both V & I (volts and amps). This  icon is replaced with the  icon on the detail 
views, as voltage and current data can be viewed simultaneously. 
In all the detail live view screens, a line selection menu is available using the  button at 
the bottom. This is a checkbox that is used to select the voltage and current channels you 
want to display. 

 
The Snapshot icon triggers the Recorder to capture high-resolution waveform data and 
save it in the recorded data stream. This waveform capture is identical to the snapshots 
taken automatically when you set the “snapshot period” in the Recorder Setup menu. 
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This icon brings up the Annotate screen. Use the annotate menu to enter text or to insert a 
file name and load it into the recorded data stream in the Recorder. Annotations can be 
used to make notes, or to insert a file name of an image or audio file. You can enter 
multiple start and stop annotations. START and stop annotations are not paired and are 
not restricted to being used as literally “start” and “stop”. Annotations are often done at 
the start of a power recording session. 
[keyboard] 
This icon brings up the standard PDA data entry keyboard. 
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Menu Tree 
The following figure provides an overview of the Power View menu structure that will be 
helpful in navigating through the Power View application. 
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Figure 15. Power View Menu Tree 
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Home Screen 
This is the top-level screen, accessed when you start Power View or when you tap View 
and them Home on the Menu Bar.  
The Home screen contains a 1.5 cycle waveform screen, a digital meter screen, and a 
PHASOR screen. The parameters shown in this screen are not configurable. All phases 
are shown simultaneously, either all voltage or all current.  

 
If no Recorders are within range, the following screen appears: 
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If more than one Recorder is within range, the Recorder selection screen appears. An 
asterisk preceding the Recorder name means that unit is password protected. 

 
 
If the selected Recorder is not password protected, the Home screen appears. If password 
protection is set, the Password screen appears instead. 

 
 
If you enter an incorrect password, the following message appears: 
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When the password is accepted, the Home screen appears.  

Note 
A screen to set up password protection for a Recorder is provided in the 
Setup menu. 

Downloading Data and Erasing Memory 
Use the Data menu options to manage the Recorder memory and download recorded data 
to the SD card plugged into the Recorder's (not the PDA) SD card slot. You are 
downloading recorded data from the flash memory to an SD card in the Recorder. When 
you want to use that data, you must move the card to the PDA. You can later copy the 
data to your PC for review using the Power Analyze software. Tap 1750 Internal 
Memory to view the Download screen. 

 
 

The Download screen shows a three-phase rms V strip chart with date and timescale 
shown. This represents the data in the Recorder internal memory. The default settings of 
the start and stop times is everything in memory. To download ALL, tap the Write to SD 
button. If you want to trim off data that contains partial information because probes were 
being connected, select the START mark annotation (if one was entered by the user) as 
the start point. 
The gray cursor lines right and left with triangular arrowheads at the bottom of the screen 
show the start and stop times currently selected for download. Green and red flags are 
START and STOP mark annotations inserted during the recording session. Yellow flags 
are file name annotations inserted during the recording session, or setup parameter 
changes that change the data significantly, such as nominal voltage or power type. 
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If the SD storage card already contains data files, it may not have room for the new 
download. Power View alerts you to this condition and asks if you would like to erase the 
SD card before downloading.  
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The Memory Card Full message appears for 5 seconds, followed by the screen below. 
You can also access the download menu by selecting Data > Recorder SD Memory. 
You can delete files as necessary, and when satisfied that there is room on the card, 
proceed to write the selected internal Recorder memory data to the SD card. 

 
 

When there is room on the card, a message confirming the download will appear. 

 
 

You can also tap the Erase Recorder Memory from the Data menu option, and tap the 
Erase All button to erase all power quality data stored in the Recorder. Even then, if you 
want, you can leave old data in Recorder memory. It will be overwritten automatically 
when you start your next Recorder session, so it never has an adverse effect on recorded 
data quality or quantity. 
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When you choose to Erase All, the following popup caution “Are you sure?” appears on 
the screen. 

 
 

Note 
You can also download data by connecting your PC directly to the 
Recorder with an Ethernet cable and run Power Analyze in the 1750 Live 
mode. All of the functions (controller, PDA, and Power View) are 
duplicated in 1750 Live mode. 
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Viewing Live Data 
The View menu is used to view live data on the circuits on the circuits for example, 
Scope, Meter, Phasor, or Harmonics.  

 
 

Scope Screen 
The Scope screen shows 1.5 cycle waveform data for the volts and amp lines selected in 
the check boxes on Phase View screen. Tap the Phase icon ( ) to display the Phase 
View screen.  
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Meter Screen 
The Meter screen shows numeric readings for all selected phases. 

 
 

Phasor Screen 
The PHASOR screen shows voltage (long arrows with solid arrowheads), current 
amplitudes, and phase angles. This screen is used to verify proper test lead and current 
probe connections. You can use the V and A arrows on the upper right of the screen to 
change the scaling of voltage and current on the PHASOR diagram. 
You can easily correct an erroneous Recorder connection by going directly to 
Setup\Phase Swap ( ) and using the Recorder to internally invert a CT, swap a voltage 
or CT phase, or modify a scaling parameter, then return to the screen to verify that the 
correction has been made. There is no need to touch the cables. See “Phase Swap” later in 
the manual for additional information. 
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Trend Screen 
The Trend screen shows live data being recorded as a strip chart display of the selected 
phases of voltage or current. This moment in time is visible on the right side of the graph.  
The traces fill the screen in 10 minutes, and continue FIFO (first-in, first-out). This 
feature is intended to paint a picture of the short-term stability of the power system. The 
V and A scaling arrows on the upper right work like the scaling arrows on the PHASOR 
screen. 

 

Harmonics Screen 
The Harmonics screen shows the magnitudes of the selected phases of V and I. The scale 
is % of nominal.  
The slider control displays harmonics of a higher order up to the 50th. The V and A 
scaling arrows are on the screen in the upper right. 
If the power type is delta, V phases are AB, BC, and CA (L1L2, L2L3, L3L1 is available 
as a localized European labeling scheme). If the power type is Wye, V phases are AN, 
BN, CN, and NG. (N = neutral, G = ground). 
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Viewing Phases 
In all the detail Live View screen, a line selection menu is available using the  button 
at the bottom. The Phase Selection screen reveals check boxes for selecting the voltage 
and current channels you want to display. 

 

Setting Up the Recorder 
To adjust the settings of the Recorder, tap Setup > 1750 Setup.  
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The Setup screen shows set up options, with icons for available actions.  

 
 

From the Setup screen, you can adjust either the recording period information or the 
Recorder settings. Tap an icon on the Setup screen to view or configure: 
• Clock 
• Probe Detect 
• IP Address 
• Nominal Power 
• Instrument Name/Password 
• Phase Swap 
• Volts/Current Ratio 
• Snapshot Period 

Setting the Clock 
Use this feature to set the PDA clock or clock to synchronize the Recorder with the PDA 
clock.  
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Probe Detect 
This screen shows the types of probes attached to the Recorder current inputs. Current 
probes are automatically detected.  

 

Setting the IP Address 
Select Automatically Obtain Address unless your company's IT department has specific 
requirements that require assigned IP addresses. 
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Overwriting Nominal Power Values 
Nominal power values are auto-detected by the Recorder and shown as the defaults. You 
can overwrite these settings by change the Recorder’s internal configuration to optimize 
power quality data recording custom settings.  

 

Assign Recorder Name and Password 
Use this feature to assign a name identifier to the Recorder and to establish a password 
for the Recorder. This naming feature is designed to help you keep track of which 
Recorder is in use. The Recorder name is later associated with the data file that you 
download from the Recorder. 
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Using Phase Swap 
Rather than having to change the physical connections to the power system, use the Phase 
Swap feature to make a software-selectable correction without physically switching the 
cable. You can select from the following: 
• Swap any voltage input 
• Swap any current input 
• Invert any current input clamp 
The screen shows check boxes to invert any current probe. Current probes are directional, 
and selecting “invert” has the effect of removing the probe and turning it around. 
If the power type is delta, V phases are AB, BC, and CA (L1L2, L2L3, L3L1 is available 
as an optional setting). If the power type is Wye, V phases are AN, BN, CN, and NG. (N 
= neutral, G = ground). 
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Setting the Volts and Current Ratio 
Use this menu to add a ratio factor to the voltage or current input on each phase. 
Changing the first “1” in each case if there is a potential transformer in series with the 
voltage connection such as when you want to monitor a medium-voltage network using 
PTs and CTs to scale the voltage and current to a convenient level for measuring 
instruments. 
The current ratio applies a ratio to the current input in order to show the current present 
on a medium-voltage network. This feature is intended to be used for sensing low levels 
of current to represent the much higher levels on the primary side at a substation or 
step-down transformer that has built-in metering current transformers. 
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Setting the Snapshot Period - Periodic Waveform Capture Setting 
Use the Snapshot Period screen to program the Recorder to take automatic power 
conditions readings which are then stored in the recorded data stream. These snapshots 
contain a phasor diagram, waveforms of current and voltage, harmonics profiles, and 
other data. 
• None 
• 10 minutes 
• 30 minutes 
• 1 hour 

Note 
You can take a snapshot manually at any time at any time while connected 
over the wireless link to a Recorder. Press the Waveform icon  on any of 
the View screens to take a snapshot. The message, “Snapshot Acquired” 
confirms that a snapshot was taken. 
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Working with Annotations 
Annotations are optional markers that can be inserted by the Recorder operator to flag a 
particular point in the data when recording. They are usually inserted on using Power 
View with the wireless PDA.  

 
There are five types of annotations:  
• START annotation (green) 

The START annotation can be used to signify where important data begins. For 
example, the operator might want to establish a start annotation after having finished 
all probe connections and instrument setup, to indicate that any preceding data was 
preliminary.  

Note 
You are not limited to using the START and STOP annotations in pairs, or 
to show a range of data. You can use each as many times as desired to 
mark a particular point during recording.  

• STOP annotation (red)  
The STOP annotation can be used to signify where important data ends. 

• File annotation (yellow) 
File annotations contain the name of a picture or audio file relevant to the data. See 
“Using Image or Voice Annotations” later in this manual. 

• Text annotation  
Text annotations contain a text note.  

• Power Configuration Change annotation  
Power Configuration Change annotations are inserted by the system when a change is 
made to the Power Configuration in the Recorder. These markers only display in the 
Download dialog box. 

To show or hide annotation markers: 
• In the Volts/Amps/Hz or Events view, check or uncheck the Annotations option on 

the view controls. 
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To open an annotation: 
• In the Volts/Amps/Hz view, Events view, or Download dialog box, click on the 

annotation.  

If the annotation is associated with an audio (.WAV) or image (.jpg) file, the 
application associated with that file will start and open the file. If the file is not in the 
default directory My Documents\Fluke\PQ Analyze, a dialog box opens so that you 
can navigate to the file. 

Note 
If clicking on an annotation marker does not seem to do anything, the Zoom 
box is probably selected in the graph toolbar, instead of the Select tool. 
Click the Select tool and then select the annotation. 

To see overlapping annotations: 
Sometimes annotations are so close to each other that they actually overlap on the 
Volts/Amps/Hz reference graph. When this is the case, if you click on overlapping 
annotations, a menu opens and you can select either Open, to open the annotation now on 
top, or Select Next Overlapping Annotation, to bring the next one to the top.  
• To open the annotation now on top, choose Open. 
• To bring the next annotation to the top, choose Select Next Overlapping Annotation. 

To then open that annotation, click on it again and choose Open. 

Note 
To see overlapping annotations more clearly on the Volts/Amps/Hz 
reference graph, move the selection cursors so that they just surround the 
area that contains the overlapping illustrations. The Detail graph adjusts 
as the cursors move, zooming in to show the area between the selection 
cursors. You can now see the annotations separately.  

Using Image or Voice Annotations 
While you are monitoring data with a Recorder, you may find it helpful to take a picture 
that relates to the power quality data you are recording, or to record verbal comments as 
you observe the conditions or review the data being measured. You can then associate the 
image or recording with the data being recorded by adding annotations that reference 
them.  
The PDA includes a microphone for recording notes which are saved as .WAV files, and 
an optional camera accessory is available on the PDA which will capture images as .jpg 
files.  
You can associate both images and audio files with the data being gathered in the 
Recorder by inserting annotations and specifying the name of a .WAV or .jpg file. After 
you download data from the Recorder, you can then move the image and audio files to 
the PC along with the recorded data (.odn) file.  

Note 
You can also associate other types of files with the annotation. For 
example, if you had a .MPG file with a movie, or a .DOC file with 
associated information. You can enter any file name using this annotation 
method. 
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Inserting Image or Voice Annotations  
1. Set up the Recorder and begin monitoring. 
2. Using your PDA-cam or another camera, take a picture of what you want to capture. 
3. Click the Annotate icon to display the Annotate screen.  
4. Move the image or audio file to a location that will make it easier to Transfer it to a 

PC later, when you download and move the recorded data file to your PC. Place the 
file into the synchronization folder on your PDA, so that it will be automatically 
transferred into the sync folder on the PC the next time you dock the PDA. 

Cleaning and Maintenance 
• The Recorder contains no user serviceable parts. Contact an Authorized Fluke 

Service Center for repair. 
• Periodically wipe the case with a damp cloth and mild detergent. Do not use 

abrasives or solvents. 

Regulatory Information for Wireless Communication 
WCaution  

Any changes or modifications to the wireless 2.4GHz radio not 
expressly approved by Fluke Corporation could void the user's 
authority to operate the equipment. 
FCC ID: T68FLK1750 
IC: 6627A-FLK1750 

This device complies with Part 15 of the FCC Rules. Operation is subject to the following 
two conditions: (1) this device may not cause interference, and (2) this device must 
accept any interference, including interference that may cause undesired operation of the 
device. 
Class A digital device: A digital device that is marketed for use in a commercial, 
industrial or business environment, exclusive of a device which is marketed for use by 
the general public or is intended to be used in the home. 
Class B digital device: A digital device that is marketed for use in a residential 
environment notwithstanding use in commercial, business and industrial environments. 
Examples of such devices include, but are not limited to, personal computers, calculators, 
and similar electronic devices that are marketed for use by the general public. 
The Fluke 1750 Power Recorder (wireless host) has been tested and found to comply 
with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These 
limits are designed to provide reasonable protection against harmful interference when 
the equipment is operated in a commercial environment. This equipment generates, uses, 
and can radiate radio frequency energy and, if not installed and used in accordance with 
the instruction manual, may cause harmful interference to radio communications. 
Operation of this equipment in a residential area is likely to cause harmful interference in 
which case the user will be required to correct the interference at his own expense. 
In addition, the internal limited modular radio has been tested and found to comply with 
the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits 
are designed to provide reasonable protection against harmful interference in a residential 
installation. This equipment generates, uses and can radiate radio frequency energy and, 
if not installed and used in accordance with the instructions, may cause harmful 
interference to radio communications. However, there is no guarantee that interference 
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will not occur in a particular installation. If this equipment does cause harmful 
interference to radio or television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct the interference by one or 
more of the following measures: 
• Reorient or relocate the receiving antenna. 
• Increase the separation between the equipment and receiver. 
• Connect the equipment into an outlet on a circuit different from that to which the 

receiver is connected. 
• Consult the dealer or an experienced radio/TV technician for help. 
The term “IC:” before the radio certification number only signifies that Industry of 
Canada technical specifications were met. 

Specifications for the System: Recorder and Power Analyze 
Software 

General Specifications 
Power Quality Measurement Standards  
Conformance..................................................... IEC 61999-1-4 Class 1, IEC 61000-4-30 Class A or B depending on 

measurement function, IEEE519, IEEE1159, IEEE1459 
Clock/Calendar.................................................. Leap years, 24-hour clock 
Real-time Clock Accuracy................................ Not more than ± 1 s/day 
Internal Memory Capacity for Data ................. At least 1 GB 
Maximum Recording Period ............................ At least 31 days 
Measurement Time Control ............................. Automatic 
Maximum Number of Events ........................... Limited only by the size of the internal memory. 
Power Requirements ........................................ 100 to 240 V rms ±10%, 47-63 Hz, 40 W 
Operating Time During Interruptions  
(Internal UPS operation) ..................................... 5 minutes per interruption, 60 minutes total operating time without 

recharging 
Dimensions ....................................................... 215 x 310 x 35 mm (8.5 x 12.2 x 3.5 inch) 
Mass (Weight) ................................................... 6.3 kg (14 lbs) 

Input Specifications 
Measurement Types ......................................... One Phase Plus Neutral, One Phase IT No Neutral, One Phase Split 

Phase, Three Phase Wye, Three Phase Delta, Three Phase IT, Three 
Phase High Leg, Three Phase Open Leg, 2 Element Delta, 2 ½ 
Element Wye 

Input Channels .................................................. Voltage: 5 channels, AC/DC 
Current: 5 channels 

Voltage Channels.............................................. Input resistance: 2 MΩ 
Input capacitance: < 20 pF 

Current Channels.............................................. 1 MΩ. Self-identifying probes 
Types available: current probes, Flexi-CTs 

Measuring Method ............................................ Simultaneous digital sampling of voltage and current. Digital PLL 
synchronized sampling, internal frequency reference used during 
voltage drops. 

Synchronization and Sampling 
PLL-Synchronization Source........................... The PLL synchronizes to the A-N voltage for wye power types, and t 

the A-B voltage for delta power types. All listed power types can be 
characterized as either wye or delta. 

PLL Lock Range................................................ 42.5 to 69 Hz 
Sampling Frequency ........................................ Voltage and current: 256 samples/cycle 

Inter-harmonics per IEC61000-4-7: 2560 points / 10 cycles (50 Hz),  



 Power Recorder 
 Specifications for the System: Recorder and Power Analyze Software  

  49 

3072 points/12 cycles (60 Hz) 
Transient Voltage: 5 MHz 

A/D Resolution .................................................. Voltage and current: 24 bits 
Transient voltage: 14 bits 

Voltage and Current Measurements 
Voltage Measurement Range........................... AC voltage: 1000 V rms ± 10% Overrange 

DC voltage: ±1000 V + 10% Overrange  
Voltage Crest Factor......................................... 3 or less 
Voltage Input Impedance ................................. 2 MΩ 
Current Measurement Range........................... Depends on current probe used 
Current Crest Factor......................................... 4 or less 
Current Input Characteristics .......................... 2 V rms = full scale, 1 MΩ Input Impedance for ferro CTs, low 

impedance for Flexi-CTs 

Voltage and Current Measurement Accuracy 
RMS Voltage 
Measurement Type............................................. True rms calculated continuously: every cycle, every 1/2 cycle, and 

every 10 or 12 cycles at 50 or 60 Hz respectively, as required by IEC 
61000-4-30. 

Measurement Uncertainty................................... AC: ± 0.2 % reading ± 0.1 % full scale above 50 V rms 
DC: ± 0.5 % reading ± 0.2 % full scale above 50 V dc 
If the ac component of a dc signal is below 40 V rms, the dc 
uncertaintly specification may have an offset. 

RMS Current 
Measurement Type............................................. True rms calculated continuously: every cycle, every 1/2 cycle, and 

every 10 or 12 cycles at 50 or 60 Hz respectively, as required by 
standards 

Measurement Uncertainty………........................ ± (0.1 % full scale + 0.5 % reading + current sensor accuracy), valid for 
5 % to 100 % of current sensor range 

Current Accuracy……………… .......................... Ferromagnetic Clamps 
                                                                             ± (0.1 % full scale + 0.2 % reading + current sensor accuracy), valid for 

5 % to 100 % of current sensor range 
                                                                             Flexible Current Probes 
                                                                             ± (0.1 % full scale + 0.5 % reading + current sensor accuracy), valid for 

5 % to 100 % of current sensor range 

Transient Voltage (Impulse) 
Measurement Type............................................. Waveshape sampling, not peak detect 
Full Scale ............................................................ 8000 V pk 
Sample Resolution.............................................. 200 nS 
Measurement Uncertainty................................... ± 5 % reading ± 20 V (test parameters: 1000 V dc, 1000 V rms,  

100 kHz) 

Dip (Sag) and Swell Measurements 
Voltage Swell (rms swell) 
Measurement Type............................................. True rms (one cycle calculation by overlapping each half cycle) 

(voltage between lines is measured for 3P3W lines and phase voltage 
is measured for 3P4W lines) 

Displayed Data ................................................... Amplitude and duration of swell 
Measurement Accuracy...................................... Same as rms voltage 
Voltage Dip (RMS sag) 
Measurement Type............................................. True rms (one cycle calculation by overlapping each half cycle) 

(voltage between lines is measured for 3P3W lines and phase voltage 
is measured for 3P4W lines) 

Displayed Data ................................................... Amplitude and duration of dip or interruption 
Measurement Accuracy...................................... Same as rms voltage 
Voltage Dropout (Interruption) 
Measurement Type............................................. Same as Voltage Dip 
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Power and PF Measurement 
Calculated per IEEE1459 for best performance when distortions exist 
Measurement Type............................................. True rms calculated continuously: every cycle, and every 10 or 12 

cycles at 50 or 60 Hz respectively, as required by standards 
Measurement Accuracy ...................................... ± 0.2% reading ± 0.1% full scale + current sensor accuracy 
Frequency 
Measurement Range .......................................... 42.5 to 69 Hz 
Measurement Source ......................................... Same as PLL synchronization source 
Measurement Accuracy ...................................... ± 10 mHz (10 to 110% of range, with sine wave) 
Reactive Power 
Accuracy ............................................................. ± 0.2% reading ± 0.1% full scale + current sensor accuracy 
Power Factor 
Measurement Range .......................................... -1.000 (leading) to 0.000 to +1.000 (lagging) 
Measurement Accuracy ...................................... ± 1 digit from the calculation of each measured value (±3 digits for 

total) 
Displacement Power Factor 
Measurement Method......................................... Calculated from the phase difference between voltage fundamental 

and current fundamental 
Measurement Range .......................................... - 1.000 (leading) to 0.000 to + 1.000 (lagging) 
Measurement Accuracy ...................................... ± 0.5% reading ± 2% full scale ± 1 digit 
Voltage Unbalance and Phase Sequence 
Measurement Method......................................... Positive sequence voltage divided by negative sequence voltage, per 

IEC 61000-4-30 
Harmonic Voltage and Current 
Analysis Window................................................. rectangular 
Analysis Order .................................................... 1st to 50th order 
Measurement Accuracy ...................................... Voltage / Current: 1st to 20th orders: ± 0.5% reading ± 0.2% full scale 

21st to 50th orders: ± 1% reading ± 0.3% full scale 
(current sensor accuracy must be included for current and power) 

Measurement Method......................................... IEC 61000-4-7 
Inter-harmonic Voltage and Current (Intermediate Harmonics) 
Analysis Window................................................. rectangular 
Analysis Orders .................................................. 0.5 to 49.5th order 
Measurement Method......................................... IEC 61000-4-7 

External Interface Specifications 
LAN Interface 
Connector ........................................................... RJ-45 
Speed and Type ................................................. 10/100 Base-T, auto MDIX 
Communications Protocol ................................... TCP/IP over Ethernet 
Wireless Controller Interface 
Connection.......................................................... wireless (2.4 GHz radio) 
Speed ................................................................. up to 700 kbit/second 
Communications Protocol ................................... Bluetooth SPP 

Environmental and Safety Specifications 
Operating Environment....................................... indoors or in covered area outdoors, up to 2000 m altitude 
Storage Temperature and Humidity.................... -20 °C to 50 °C, 80 % rh max, non-condensing 
Operating Temperature and Humidity ................ 0 °C to 40 °C, 80 % rh max, non-condensing 
Maximum Rated Working Voltage 
Voltage Terminals ............................................. 1100 V rms 
Voltage Durability................................................ 5550 V rms ac for 1 minute, between voltage input terminals, voltage 

input terminals and current probes, and voltage input terminals and 
case (50/60 Hz, 1 mA sense current) 

Enclosure Protection........................................... IP30 (per EN 60529) 
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Standards Conformance 
EMC.................................................................... EN 61326-1:1997+A1:1998 Class A 

EN 61000-3-2:1995+A1:1998+A2:1998 
EN 61000-3-3:1995 

Safety.................................................................. EN 61010-1:1993+A2:1995 
Voltage input unit: Contamination Level 2 
Overvoltage Category 1000 V CAT III, 600 V CAT IV (anticipated 
overvoltage: 8000 V) 
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